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Preface

This document contains release notes describing enhancements and repairs to this release of 
Oracle Utilities Work & Asset Management. Items are sorted by subsystem and module, then by 
Bug DB number.

Audience
These release notes are intended for anyone installing or using Oracle Utilities Work and Asset 
Management Release 1.9.1.2.5.

Related Documents
For more information on this release, refer to the following related documentation. Please ensure 
that you are using the appropriate guide based on whether you are installing on Windows or Linux 
Application Server.

User Documentation
• Oracle Utilities Work and Asset Management Configuration Guide for Release 1.9.1.2.5
• Oracle Utilities Work and Asset Management Online Help for Release 1.9.1.2.5
• Oracle Utilities Work and Asset Management User Guide for Release 1.9.1.2.5
• Oracle Utilities Work and Asset Management Customization Guide for Release 1.9.1.2.5

Installation Documentation

About the Release
• Oracle Utilities Work and Asset Management Quick Install Guide for Release 1.9.1.2.5
• Oracle Utilities Work and Asset Management Release Notes Guide for Release 1.9.1.2.5

New Installations
• Oracle Utilities Work and Asset Management Installation Guide for Release 1.9.1.2 on Linux OS 

Application Server
New installation on WebLogic /Linux OS

• Oracle Utilities Work and Asset Management Installation Guide for Release 1.9.1.2 on Windows OS 
Application Server
New installation on WebLogic / Windows OS
Oracle Utilities Work and Asset Management - 5
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Conventions
Supporting Docs
• Oracle WebLogic Server Product Documentation: 

http://www.oracle.com/technetwork/middleware/weblogic/documentation/
index.html

• Oracle Fusion Middleware Patching Guide for Oracle Forms and Reports 11g Release 2 (11.1.2) 
(Part Number E36789-04)
http://docs.oracle.com/cd/E48391_01/doc.11120/e36789/opatch.htm

• 6.5 Installation on Operating Systems Not Certified at the Time of Product Release
http://docs.oracle.com/html/E18558_01/fusion_requirements.htm#BABCEFEA

Knowledge Base Articles
Please access https://support.oracle.com to find related knowledge base articles.

• Support for Add-ons: Article ID 1336258.1
• Changing the Default Download Directory For Forms WebUtil Client Files: Article ID 

783937.1

Conventions
The following text conventions are used in this document:

Convention Meaning

italic Italic type indicates book titles, emphasis, or placeholder variables for 
which you supply particular values.

monospace Monospace type indicates commands within a 
paragraph, URLs, code in examples, text that 
appears on the screen, or text that you enter.
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Chapter 1
Supported Platforms and Hardware

Requirements

This section provides information regarding the operating systems and servers on which this 
release has been tested and certified. 

Supported Platforms
The installation has been certified to operate on many operating system, application server, and 
database server combinations. See below for details on the browser, operating system and 
application server combinations on which this release has been tested and certified. If you are 
consulting this matrix in between releases (including service pack and patch releases), you should 
contact customer support for the most up to date version.

Operating 
System Chipset Application 

Server
Database 
Server

Client 
Operating System

*AIX 6.1 TL4 (64-bit) 
*AIX 7.1 TL4 (64-bit) 

Power
64-bit

Not Supported Supported
Oracle Database
versions include
11.2.0.3 Standard 
or Enterprise
Edition
 
and 

Oracle Database 
12c Standard or
Enterprise 
Edition 
12.1.0.1.0 - 64bit 
Production

Windows7 x86 SP1
(64-bit and 32-bit)

Oracle Enterprise Linux 
6.5 (64-bit)

Oracle Enterprise Linux 
5.8 & 6.5 (64-bit)

Red Hat Enterprise Linux 
5.8 & 6.5 (64-bit)

x86_64 Weblogic Server 10.3.6
Forms 11g 11.1.2.2

*Solaris 11 (64-bit) SPARC Not Supported

HP Itanium HPia 11.31 x86_64 Not Supported

Windows 2008 Server
 Enterprise Edition R2 
(64-bit)

x86_64 Weblogic Server 10.3.6
Forms 11g 11.1.2.2
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Supported Platforms
Client Operating System Specific

Browsers
• Internet Explorer 11 (32-bit) - not supported on Linux client
• Internet Explorer 9.x (32-bit) - not supported on Linux client
• Mozilla Firefox ESR 31 (32-bit)

Java
•  Java Runtime Environment (JRE) / Java Virtual Machine (JVM) Plug-in for Browser 

This list reflects the highest supported versions. Refer to the community website for a 
full list.
• v1.8.0_45-b15 (32-bit)

• v1.7.0_80-b01(32-bit) 

Application Server Specific

Java
• JDBC Driver 11.2.0.2.0 (WebLogic)

Integrations
• Barcode

• RFGen v3.2.1.28 

• Loftware 9.5 

• GIS - ESRI ArcGIS 10.2
• GIS - Oracle MapViewer 10.1.3.4 
• Microsoft Project 2007
• Oracle Business Intelligence Publisher 11g Release 1 (11.1.1.7.0)
• Oracle Business Intelligence v2.4.0
• Oracle Integration Pack for Oracle Utilities Field Work v3.1
• Oracle Integration Pack for Oracle Utilities Field Work v12.1
• Primavera 8.3

VM Products
• Oracle VM 3.x

Notes
• Oracle Utilities Work and Asset Management discontinued support and releases of 

applications on Oracle Application Server (OAS) in release 1.9.1 due to the de-support 
of this platform by the Oracle Server Group as of December 2012.

• Forms Premier Support has ended as of as of June 2014. Refer to Oracle Forms/Reports 
11gR1 (11.1.1.x) Premier Support Ends (Doc ID 1680259.1) on https://
support.oracle.com.

• ESRI ArcIMS and ESRI ArcMAP are no longer supported as of release 1.9.1.2.2.
• Oracle VM may be used to create a virtual machine for either the database or application 

server operating system. Refer to the Oracle VM Release documentation for more 
information about using Oracle VM.

• Barcoding and Chart server add-on applications do not run on Linux. Please refer to 
knowledge base article ID 1336258.1 on https://support.oracle.com for more 
information. 

• Fine Grain Access functionality requires Enterprise Edition Database Server.
• * If your database server is installed on AIX, HP or Solaris, please refer to the database 

support document for these servers. 
Oracle Utilities Work and Asset Management - 8
Release Notes for Release 1.9.1.2.5 Doc v1 rev.0 7/16/15



Support for Software Patches and Upgrades
• You can also refer to the Oracle Utilities Work and Asset Management community 
website for more information on this release and interaction with the application 
community. 
https://communities.oracle.com/portal/server.pt/community/
work_and_asset_management/527

Support for Software Patches and Upgrades
Due to the ongoing nature of software improvement, outside vendors and other Oracle products 
will issue patches and service packs for the operating systems, application servers and database 
servers on top of specific versions that Oracle Utilities Work and Asset Management has been 
tested with. If it is necessary to apply an upgrade, please do that in a test environment prior to 
updating the Oracle Utilities Work and Asset Management production environment. 

Always contact Oracle support prior to applying vendor updates that do not guarantee backward 
compatibility.
Oracle Utilities Work and Asset Management - 9
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Chapter 1
Release Notes

These release notes contain the following sections:

• About This Release

• Known Issues

• Integration Information

• Fixes and Enhancements

About This Release
Refer to the quick install guide and upgrade guide for information regarding certifications, 
supported platforms and installation steps. 

Please visit My Oracle Support (http://support.oracle.com) for the most recent service packs 
and/or patches for this release to ensure you have the most current version of this product.

11G Database Support
If you are upgraded to the Oracle Database 11g, a special script is required to allow email and 
product integration URLs to be successful as in older versions of the database (8, 9i, 10g). Follow 
the instructions in the Oracle Utilities Work and Asset Management Upgrade Installation Guide to meet 
this requirement. 

Please refer to the Oracle 11g DBMS documentation located on support.oracle.com for more 
details on how to restrict unwanted URLs.

Charts Server and Thumbnails
In Release 1.9.1, functionality to support chart thumbnails was removed due to Microsoft 
desupport of XP Web Components. As a result, charts are still supported with the following 
provisions: 

• Chart thumbnail generation of charts on the home page is no longer supported. This 
functionality was replaced with static images that represent the chart graphic. Clicking 
the static image launches the corresponding chart. 
Office Web Components (required for thumbnail generation) are no longer supported 
on IIS Servers since they cannot run on a 64-bit environment

• Oracle Utilities Work and Asset Management uses XP Office Web Components to 
display the main chart. This is available and downloaded from Microsoft.

• Users can use existing charts, and can create new charts using Office XP or Office 2003. 
Later versions of Office do not support these features.
Oracle Utilities Work and Asset Management - 10
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Integration Information
Oracle Forms Patches
If there are any Oracle Forms patches that need to be applied prior to upgrading, these are 
indicated in the Known Issues section.

Previous Patches
If you have recently applied a patch, please review these notes carefully to verify that your patch is 
included in this release. In rare cases, when a patch is requested close to the release date for the 
next software distribution, there may not be time to include the patch content in the general 
release. Functionality may be impacted if you apply a release that does not include a previously 
deployed patch. Check with Customer Support to verify the status of a particular item.

Unwrapped Database Procedures
This release of Oracle Utilities Work and Asset Management includes database procedures that are 
no longer wrapped to encode the programs. This was provided to allow customers to better 
understand the business logic that happens within various procedures so that it is easier to 
integrate Oracle Utilities Work and Asset Management with other products. These procedures are 
provided as a reference resource only. They should not be altered as they are an important part of 
the Oracle Utilities Work and Asset Management Base application and changing them will cause 
adverse affects to the application.

Integration Information
The following integrations are supported in this version of Oracle Utilities Work and Asset 
Management:

Oracle Utilities Work and Asset Management Product Integrations
• Integration with Oracle Utilities Advanced Spatial Analytics, 2.4.1

Please refer to the documentation released with Oracle Utilities Advanced Spatial 
Analytics for more information. 

• Oracle Integration Pack for Oracle Utilities Field Work 3.1
This integration can be downloaded on the Oracle Software Delivery Cloud. Select 
Product Pack “Oracle Application Integration Architecture” then select “Oracle 
Application Integration Architecture Release 3.1 Media Pack for Microsoft Windows”. 

• Oracle Utilities Work and Asset Management Integration to Primavera P6 
Enterprise Project Portfolio Management 
This integration can be downloaded on the Oracle Software Delivery Cloud. Select 
Product Pack “Oracle Application Integration Architecture” then select “Oracle 
Utilities Work and Asset Management Integration to Primavera P6 Enterprise Project 
Portfolio Management Release V11.1.0.0.0 Media Pack”.

Desupported Integrations
The Oracle Utilities Customer Care and Billing Integration to Oracle Utilities Work and Asset 
Management is no longer supported. This legacy integration was deprecated with the release of 
Oracle Utilities Customer Care and Billing 2.3.1 and Oracle Utilities Work and Asset Management 
1.9 and was not certified with these versions.

Support continues for existing customers currently using or implementing this integration (i.e. 
address product defects related to this legacy integration). However the integration will not be 
enhanced or supported going forward therefore, we strongly discourage using this integration for 
new implementations. Existing customers can continue to leverage the integration patterns that 
were formerly delivered with the edge applications. However, please be advised that it will be 
necessary to maintain these as custom interfaces when upgrading to newer versions of the 
applications. Alternatively, customers can evaluate Oracle Integration Pack for Oracle Utilities 
Oracle Utilities Work and Asset Management - 11
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Known Issues
Field Work, as the productized solution. The Field Work integration is generally more robust, 
configurable, and extensible than the older integration.

Known Issues
This section describes known issues in Oracle Utilities Work and Asset Management Release 
1.9.1.2.5 at the time of release. Fixes for these issues will be released as they become available.

General Issues
• 16874363 - CU UPDATES TO ACTIVE TASK WITH HEADER AT PLANNING 

ALLOWED
Estimated Quantity, CU Function and CU Difficulty fields can be updated when the 
Task is in Active status and the Work Order header status is in Planning status. 
New bug: 19190790

• 17960789 - WORK REQUEST APPROVAL LOG RECORD NOT CREATED FOR 
PENDING APPROVAL TO WORK ORDER
The system does not log approval if the status is changed from Pending Approval to 
Work Order status. 
New bug: 19190752

• 18309319 - ADDING TASK FAILURE SUMMARY INFORMATION THRU 
WIZARD, DELETES AN EXISTING CODE 
Multiple failure data rows must be entered in the Work Order > Closeout Summary > 
Asset Failure Summary. Entering new data in the Task Progress Wizard will overwrite 
existing data.
New bug: 19190704

Oracle 11G Database
• 11G databases contain user profile features not related to Oracle Utilities Work and 

Asset Management that can still affect an Oracle Utilities Work and Asset Management 
user's ability to log in. 

If users experience problems logging in, one possible cause is that the 11G default 
profile has an expiration of 180 days.  Make sure that the PASSWORD_LIFE_TIME 
setting for the applicable database profile is consistent with Oracle Utilities Work and 
Asset Management password expiration settings. 

Consult Oracle 11g Database documentation (available on my.oracle.support) for details.

General Browser Issues
• To support readability and accessibility compliance, style changes have been made to 

specify a relative size rather than a fixed font in web browsers. This allows different text 
elements to increase or decrease in size proportion based on generic web settings. In 
some versions users might see an increase in font size on some screens. To fix this issue, 
adjust the zoom setting: 

Internet Explorer: View > Zoom (set percentage as appropriate)

Firefox: View > Zoom > Zoom Text Only then View > Zoom > Zoom In/Out (as 
needed)

Firefox
• Unable to launch the Entity Relationship Viewer. The viewer requires XSLT processing 

that Firefox is unable to perform. If the user attempts to upgrade Firefox using the 
recommended XML installer from Microsoft, the installer does not run.
Oracle Utilities Work and Asset Management - 12
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Known Issues
• Right-click context menus do not function. These are the menus specific to Oracle 
Utilities Work and Asset Management, not standard right-click functionality. 

• There is no Effects option for graphs. 

• Dialog windows show a URL box which should not be visible. This was purposefully 
hidden in Internet Explorer.

• If you find that fonts do not appear sharp in Firefox try the following fix with Windows 
ClearType to improve the clarity.  

http://risingline.com/blog/smoother-firefox-fonts-windows-xp.php

Summary of Steps 

1. Minimize all your windows and right click anywhere on your desktop. 

2. Select Properties then choose the Appearance tab then click the Effects button. 

3. Make sure the check mark is in the box next to "Use the following method to    
smooth edges of screen fonts:" and select ClearType. Then click OK. 

• There are slight differences in font display and size as well as differences in appearance 
for some portions of some components. Selecting the ClearType option as described 
above can also help to minimize this issue.

• The View Document action in Document module does not work for files which are 
stored on a shared network folder and whose storage type is ‘File System’. This is due to 
a security restriction that prevents Firefox from loading such files. The workaround for 
this issue is to manually enter the file path in Firefox’s address bar in order to load the 
file. 

Internet Explorer
• When new browser windows are opened from forms, they may appear behind the 

current window. For example, when opening Advanced Options windows, Export 
Results of Search, or opening Online Help the newly opened window may not 
automatically appear in the forefront of the screen. 

• Security features prevent charts from opening.  There are 2 settings that can be changed 
to work around this issue.  One setting is to allow the chart to run, and the second setting 
is to disable the warning dialogs. It is recommended that these changes are limited to 
trusted sites or the local intranet: 

1. In Internet Explorer select Tools > Internet Options.

2. Select the Security tab.

3. Click the Custom Level button.

4. Under Miscellaneous - "Access data sources across domains" -- set  to Enable 
instead of prompt (prompts are the warning dialogs).

5. Under User Authentication, Logon - "Automatic logon with current user name and 
password" -- set to "Automatic logon with current user name and password."

Windows 7 Client
• The Webutil components do not download automatically to a Windows 7 client. This is a 

known issue of the Oracle Application Server team but there is no patch to push the 
correct DLLs. This is related to new security in Windows 7.

• On Windows 7 client machines, DLL files required to run Webutil functions may not 
download to the client machine. This is a known issued caused by security features in 
Windows 7 operating system. You can work around this issue by configuring Webutil to 
download the required DLL files into a directory that is not restricted. By default, the 
Oracle Utilities Work and Asset Management - 13
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Known Issues
directory will be the user's home directory, but you can choose a specific path. This 
configuration change will be used for all client machines accessing the OC4J instance.

Within the webutil.cfg file, make sure the following setting is available. 

    install.syslib.location.client.0

The default value will be the user's home directory on the client machine. On Windows 7 
client machines, this is usually "\Users\username", where "username" is the Window's 7 
username currently logged in. You can determine what the user's home directory is by 
issuing the command "s" within the Java Plug-in Java Console and looking for the 
"user.home" setting.

Setting the "install.syslib.location.client.0" value to a relative path (not including the 
drive), will write to a directory relative to the user's home directory. For example, you can 
use "install.syslib.location.client.0=webutil", and this will add the DLL files to 
"\Users\username\webutil". 

Reference the document titled, "How To Change The Default Download Directory For 
Forms WebUtil Client Files" [ID 783937.1] located on http://support.oracle.com for 
instructions and additional information. 

UNC, Attachments, and Java Runtime Environment 1.6.0.24 or higher 
• UNC file paths are not certified or supported in Oracle Utilities Work and Asset 

Management. 

After upgrading JRE to version 1.6.0.24 or higher, you may encounter security 
exceptions while viewing or printing attachments in Oracle Utilities Work and Asset 
Management. This error occurs because on JRE v1.6.0.24 or higher, webutils will not 
access UNC file path names. You can resolve the issue by updating all Document module 
records and Links/News that have UNC path names to reference a server file path or a 
URL. 

Linux Client
• To ensure that mouse focus works properly on Linux client, you must modify the 

basewam.html file to delayTime=1000 and delayTries=5. These additional settings in the 
file are meant for specific environments that require further delays to allow Java and 
Forms to load before a Forms request is made. By default, there is minimum to no delay. 

• Different desktop screen resolutions affect the Forms applet font sizes and placement of 
items on canvases. The recommended screen resolution on a Linux client is 1280 x 1024.

• The following features which require client-side file manipulation do not currently 
function on a Linux client: 

1. Viewing, Uploading, Downloading and Printing documents and attachments

2. Using RFQ Import/Export wizard features

3. Launching third-party applications that are not web-based applications (MS project 
integration, GIS non-web-based vendor integrations etc)

4. Using Operational Data Wizard features

These features require an enhancement which will be delivered in a later release.

Report Engine
Report jobs randomly failing with error: REP-300/501.

The problem happens for reports started via forms/run_report_object or using “rwservlet” 
with desformat PDF, destype cache or file. After the first reports job has crashed, all 
following jobs of any kind return with error REP-501, so the engine cannot connect to the 
Oracle Utilities Work and Asset Management - 14
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Fixes and Enhancements
database again until the reports server is restarted or engLife is accessed and the engine is 
restarted.

Please refer to Document ID: 1270315.1 on my.oracle.support.com for more information. 

Report Builder
Reports Builder fails when attempting to run it from the Start menu. No error is displayed, 
only an MS-DOS window flashes quickly then nothing else happens. 

Please refer to Document ID: 1509064.1 on my.oracle.support.com for more information. 

Error When Opening PLL Forms After Installation
FRM-40735 and ORA-06508 errors raised when you exit from a Called Form with attached 
libraries.

Please refer to Document ID: 1170133.1 on my.oracle.support.com for more information.

Fixes and Enhancements
This section describes bug fixes and enhancements in Oracle Utilities Work and Asset 
Management Release 1.9.1.2.5 at the time of release. Please refer to the list of fixes and 
enhancements for complete details. You can also access the spreadsheet provided with the 
documentation for this release. 
Oracle Utilities Work and Asset Management - 15
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1.9.1.2.5 Release Notes
E

Bug DB# Module Description
Prior 
Rel

Parent 
Bug#

Resource
20617811 Asset Fixed Asset Downtime Summary view to display complete details of 

downtime log from work order. Fixed the duplicate entry for downtime log 
created from Asset Activity Log module.

Maintenance
20964551 Work Order > Task > 

Construction Assets
Correct error in construction asset valuation where all assets are 
generated from the same Compatible Unit.

20906376 Work Order Wizard ORA-06502: PL/SQL: numeric value error is no longer encountered when 
creating Checkout Request for 100+ Material records in Work Order Task.

20431479 Work Request Fixed error to ensure Work Request attachments flagged to copy to the 
Work Order are copied to the newly created Task from the Work Request.

20713776 Work Order
Benchmark Work Order

The Export action now works correctly for all export type options from the 
Work Order > Task > Items Worksheet and Benchmark > Task > Items 
Worksheet.

20960017 Subproject Fixed issue with email approval notification having the wrong description 
when sending Projects/Subprojects with same IDs but different Plants.

19796273 Work Order Wizard Fixed ORA-0001:  unique constraint 
(SYNERGEN.PK_SA_SERVICE_HISTORY_DATA) violated.

20930793 Work Order Task When updating an Approved Work Order Task to Active then immediately 
updating it to Finished, "FRM-40654: Record has been updated by another 
user" is no longer encountered, Closeout wizard is now appears correctly.

20808862 Work Order Task Fixed issue when adding a new Material and the cursor is not at the bottom 
of the Materials List, record shown is incorrect. Now on save, cursor is 
redirected to the newly created record.

17382261 Work Order Task Fixed mouse focus issue when form is launch from SIA Daily Scheduling.

16239236 Daily Schedule
Fleet Work Order
Work Order Task

Updated the process of opening multiple records using drilldown from the 
Daily Schedule to prevent the cursor from locking in the first navigatable 
field on the form.

21094000 Project / Subproject
Work Design
Work Order

Updated the database package sdbp_regulatory_accounting to handled 
overhead distribution estimates for high value Work Designs added to 
Work Orders associated to a Project / Subproject with regulatory account 
overhead distributions.

Integrations
20783777 wifp_invoice_interface Modified the database procedure: wifp_invoice_interface to check the 

Business Rule: INVOICE SETUP CRITERIA option POST INVOICE to 
determine if sdbp_approve_invoice should be called.  If the rule key is set 
to APPROVED then the Purchase Order line item and Storeroom 
Transaction log will be updated with invoice quantity and cost. A row will be 
added to the Account Log when sdbp_cost_invoice is run.  If the rule key 
set to PAID then the Paid indicator on the Invoice header must be set to 
Yes and only when sdbp_cost_invoice is run will the PO line item, 
Storeroom Transaction Log and Account log will be updated. 

Checked items may require configuration following installation. 

Indicates an enhancement

Fixes and Enhancements
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Bug DB# Module Description
Prior 
Rel

Parent 
Bug#

20767822 Job Manager Added a new database procedure: sdbp_clnup_incrct_invoiced_po to be 
run to fix invoices created from wifp_invoice_interface which were not 
posted correctly and did not update the reference Purchase Order line 
items.  To execute the procedure create a batch job as: 
sdbp_clnup_incrct_invoiced_po(job number,'plant'); and execute.  Disable 
or delete the job after verifying Purchase Order have been updated 
correctly

System Administration
20788176 Responsibility Re-added CREATE NEW PROCEDURE REVISION Responsibility Function.

21093193 User Enrollment Wizard Fixed processing where usernames greater than 20 characters caused a 
forms error when assigning an Approval Title when creating a user with the 
User Enrollment Wizard

21084071 Attachment Wizard The module ATTCHMNT (Attachment Wizard) has been added to the 
forms administration module and enforces required fields and default 
values

Inventory
20931273 Stock Checkout When checking out Trackable Stock Items for Work Order Tasks, system 

now also checks for non P or F Assets on Work Order Task's Asset List.

21282221 Stock Checkout Updated form validation processing to check for required fields on all 
checkout types.

Enterprise
20891512 Plant When creating new Plants, User is created in new Plant with Active status 

instead of blank.

Customer
20851647 Customer

Fixed navigation issue causing system to return to the Header screen
when using the Address List then the arrow to the Address Detail and then 
clicking on the CCB Service Agreements block. 

Interface
20078452 Alert Fixed 'Error: Unable to process alert. ORA-01400: cannot insert NULL into

("SYNERGEN"."SA_WORKFLOW_ITEM"."PRIMEKEY_PLANT")' caused 
when running WIFP_ALERT_INTERFACE with WAIF_ALERT records 
having a) blank MODULE and WHERE_CLAUSE; and b) populated 
MODULE and blank WHERE_CLAUSE

20801142 GIS Web Services Re-vamped error handling on all GIS web services to work uniformly for 
GIS integration.

SIA
20995751 Cost and Closeout On Cost and Closeout - Service History Detail page, when clicking an LOV 

with no values, nullpointer error is no longer encountered.
20950953 Approval Portal Approval Document is now displayed in the Approval Portal for the 2nd 

approver.
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Bug DB# Module Description
Prior 
Rel

Parent 
Bug#

18377219 Cost and Closeout
Scheduling - Daily
Scheduling - Workweek

Fixed issue in clicking the magnifying glass icon for Work Order Task. It 
now launches the form with no errors.

System Wide
20237217 System Wide Database changes to support Latin American Language option

20471591 SIA / Forms integration Modified the method used to call forms from SIA to remove unsupported 
object error.

20464943 SIA / Forms integration Modified the method used to call forms from SIA to prevent a blank forms 
window at relaunch of forms after forms was closed without logging out of 
the system.

20556854 SIA / Forms integration Updated general methodology used to call forms from all areas of the SIA 
home.

20410613 System Wide Oracle JRE version 1.7.0_80-b15 is now certified for WAM V1.9.1.2.5 
19026614 System Wide Oracle JRE version 1.8.0_45 (a.k.a. JRE 8u40-b14) is now certified for 

WAM V1.9.1.2.5 

Fixes and Enhancements
Oracle Utilities Work and Asset Management- 18


	Oracle® Utilities Work and Asset Management
	Release Notes
	Contents
	Preface
	Audience
	Related Documents
	Conventions

	Supported Platforms and Hardware Requirements
	Supported Platforms
	Support for Software Patches and Upgrades

	Release Notes
	About This Release
	Integration Information
	Known Issues
	Fixes and Enhancements



